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CHAPTER

1
 Desktop Inventory 7.1.1 release notes
Welcome to Peregrine Systems, Inc.’s Desktop Inventory 7.1.1, a 
minor release that replaces the previous Desktop Inventory 7.0.0 
release.

In these release notes you will find information on the following:

! New features and enhancements in v7.1.1 on page 6

! Installation information on page 10

! Related documentation on page 11

! Known issues on page 13

! Corrected issues on page 14

! Compatibility information on page 20

! Additional contact information on page 21
Desktop Inventory 7.1.1 release notes ! 5
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New features and enhancements in v7.1.1

Desktop Inventory 7.1.1 is the successor to Desktop Inventory 7.0.0, and 
primarily implements performance enhancements and fixes for issues found 
after the release.

The following enhancements were implemented:

General

Recognition Engine Optimization.
The Recognition Engine has been optimized, decreasing the time necessary 
to load scan files in Viewer, Analysis Workbench and XML Enricher. On 
average, the time required per scan file is reduced by around 30%.

Since the optimizations were done to Application Recognition, the 
performance benefit only applies when Application Recognition using SAIs 
is enabled.

Also note that performance is affected by the type of scan files loaded. It is 
generally more efficient to load FSFs than it is to load .xml.gz based scan files.

Scanners

More and better UNIX hardware detection
The Linux scanner now collects the full range of UNIX System Configuration 
data. 

The detection of User Profile data in all flavors of UNIX has been improved 
to include user name, home directory and full name of user.

CPU Model detection has been improved in HP/UX.

The AIX Scanner has been improved to detect monitor and physical disk data 
on more systems.

CPU Speed detection has been improved on Solaris, HP/UX and AIX, where 
the hwCPUSpeedMeasured field is now detected.
6 " Desktop Inventory 7.1.1 release notes 
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Improved PC hardware detection
Two new hardware fields have been added to the hwDiskData container: 
hwDiskTotalSizeMB and hwDiskTotalFreeMB. These contain the total size 
and free space of all partitions on local hard disks in a machine.

The scanners can now detect Mobile Pentium 4 and Pentium 4 Xeon 
processors.

New Scanner command line parameters
A new scanner parameter -31 can be used to disable Monitor Detection.

The UNIX Scanners have a new command line option, -excl:150, that can be 
used to disable collection of System Configuration information.

Support for Accessed timestamps
The Win32 and UNIX Scanners can now collect Created and Accessed 
timestamps for files as well as Modified timestamps.

A new option has been added to Scanner Generator, allowing the Accessed 
timestamps for scanned files to remain unchanged by the Scanner. When this 
option is enabled, the Scanner sets the timestamp back to the value it had 
before the Scanner accessed the file.

Viewer

Compare function enhanced
The compare functionality in the Viewer has been enhanced to better 
support changes in lists, such as environment variables, user profiles, disk 
data, etc.

The compare wizard now remembers the settings used on the last compare.

When comparing file data, a new option to Ignore Last Accessed Time has 
been added. If this option is not checked, it is likely that otherwise identical 
scans will show many differences.

Summary Tab
The Viewer Summary Tab now shows the Machine Name as well as other 
data.
New features and enhancements in v7.1.1 ! 7
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Scanner Generator

New option for Hidden Scanners
When creating a Hidden Scanner using Scanner Generator, a new option on 
the Scanner Options -> GUI Options tab becomes available: Do not show 
error messages. When checked, the scanner will not show any error messages 
but will instead fail and exit.

Cases where the scanner would otherwise show an error message but will 
now exit with an error code include:

! A “required” asset field is blank,

! If the machine shuts down while the scanner is running,

! Various scanning errors (Out of disk space, etc).

New option to Maximize the Scanner
On the Scanner Options -> GUI Options tab, a new option is available: 
Maximized. When selected, the GUI scanners will run in a very large 
window.

New Accessed timestamp option
A new option to preserve file Accessed timestamps has been added to the File 
Scanning > File Identification tab. 

If this is enabled, the Accessed timestamp is not changed when the scanner 
opens the file for identification and signaturing. However, enabling it causes 
the Scanners to run slower.

Analysis Workbench

Asset Field Editing
Editing of Asset Fields is now controlled on a per-machine basis. Previously, 
it was assumed that all Scanners were configured with the same Derived 
fields. Since Derived fields cannot be edited when AW is configured to auto-
recalculate their value, the columns containing Derived fields were read only.

Analysis Workbench now stores this information for each loaded scan file 
and enables editing on a per-cell basis.
8 " Desktop Inventory 7.1.1 release notes 
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State Images upgraded
State Images saves with previous versions of Analysis Workbench will not 
work with this version.

Application Encyclopedia (ApE) Explorer

New dialogs added
A new dialog to add application types and operating systems has been added.

A file properties dialog has been added.

A new login dialog has been added, to prevent unauthorized access to the 
database. For this release, a username of ApeUser and a password of 
password should be specified. Note that the user name and passwords are 
case sensitive and should be entered exactly as noted above.

Application Library
The Software Application Index (SAI) files have been updated with the latest 
set of software applications in this version.

Connect-It

Scenarios removed
The Connect-It scenarios referred to in the Desktop Inventory User’s Guide 
are not shipped with this version of the product. 

Instead, a set of connectors and scenarios are shipped with Connect-It and 
any updated to the scenarios can be downloaded from the Peregrine support 
web site.

Documentation and Help
The Data Collected by the Scanners document has been updated to reflect 
scanner changes in v7.1.1 and is now available as an HTML document 
accessible from the Start Menu.

The remaining documentation remains unchanged from v7.0.0.
New features and enhancements in v7.1.1 ! 9
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Installation information

Earlier versions of the software
Desktop Inventory 7.1.1 can co-exist with parts of previous versions of 
Desktop Inventory and InfraTools Desktop Discovery. 

The server components cannot coexist and any previous versions of these 
must be uninstalled before new ones can be installed. Server components are 
XML Enricher and ApE Server.

Important: To migrate the contents of your ApE database to the new 
version, export it as a Read-only SAI prior to uninstalling the 
previous version of ApE.

Uninstall all previous versions of the server components before installing the 
latest versions. The installer will not allow a new version to be installed before 
the old ones have been removed.

All other components (Analysis Workbench, Scanner Generator, Viewer, 
etc) can be installed in multiple versions.

MySQL
If MySQL is not installed on the machine, Desktop Inventory will install a 
version of MySQL when the ApE Server is installed. In this case, the installer 
will automatically create the necessary database and tables for the ApE 
Database.

If MySQL is already installed on the machine, Desktop Inventory will not 
install MySQL again. For security reasons it cannot automatically create the 
ApE Database and a script to do this must be run.

For further information on how to do this, refer to the Application 
Encyclopedia User’s Guide.
10 " Desktop Inventory 7.1.1 release notes 
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Related documentation

For a complete list of current Desktop Inventory 7.1.1 documentation, see 
the Documentation pages on the Peregrine Customer Support web site at 
http://support.peregrine.com. (Access to this web page requires a current 
login name and password.) 

You can download documentation PDF files and view them using Acrobat 
Reader, which is available on the Customer Support web site and through 
Adobe at http://www.adobe.com. 

The following table contains related documentation for Desktop Inventory 
7.1.1, including documents for installation (by platform), start-up use, and 
tailoring. This section also includes information about online help.

Title and Part Number Description Format

Release Notes Contains information on the following:

! New features and enhancements
! Installation information
! Related documentation
! Known issues
! Corrected issues
! Compatibility information

Print and 
PDF

Release Notes DI 7.0.0 Contains information relevant to users 
upgrading from IDD 6.03 or earlier.

PDF

Installation and Upgrade 
Guide

Explains how to install and configure 
the Desktop Inventory software.

Print and 
PDF

User’s Guide Contains details of the applications, a 
description of the features and details of 
how you would use the applications.

PDF

Application Encyclopedia 
User’s Guide

Contains details of the application, a 
description of the features and details of 
how you would use the application.

PDF

Planning Guide The guide provides an insight into some 
of the concepts and ideas behind 
planning an IT asset inventory. As such 
it is recommended reading for anyone 
planning on conducting an IT asset 
inventory using Desktop Inventory.

PDF
Related documentation ! 11
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Data Collected by the 
Scanners

This guide is for reference purposes. It 
contains information about the 
hardware and configuration data 
collected by the Desktop Inventory 
7.1.1 Scanners.

HTML

Plug-in Interface Guide Contains an overview which is intended 
for anyone with a desire to know about 
the capabilities of the Desktop 
Inventory Scanner Plug-in Interface. 
The Technical chapter is intended for 
IT staff that require intimate knowledge 
of the interface in order to implement 
customized plug-ins.

PDF

Analysis Workbench Help Contains details of the application, a 
description of the features and details of 
how you would use the application.

CHM

Scanner Generator Help Contains details of the application, a 
description of the features and details of 
how you would use the application.

CHM

Scanners Help Contains details of the application, a 
description of the features and details of 
how you would use the application.

CHM

Viewer Help Contains details of the application, a 
description of the features and details of 
how you would use the application.

CHM

Licence Manager Contains details of the application, a 
description of the features and details of 
how you would use the application.

CHM

XML Enricher Contains details of the application, a 
description of the features and details of 
how you would use the application.

CHM

SAI Update Wizard Contains details of the application, a 
description of the features and details of 
how you would use the application.

CHM

FSF Converter Contains details of the application, a 
description of the features and details of 
how you would use the application.

CHM

Title and Part Number Description Format
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Known issues

The following sections contain known issues information for this release of 
Desktop Inventory 7.1.1. 

! Issue 7625: Scan File Names in OS/2

If the default scanner is used on OS/2 systems supporting SMBIOS and the 
offsite save location is set to a FAT drive or other drive type that does not 
support long file names, the scanner cannot save the offsite scan file. This 
is because the file name is derived from the SMBIOS Asset Tag, which is 
string that is longer than 8 characters.

To scan such systems, the asset questionnaire should be changed to choose 
a different asset tag.

! Issue 7599: Publisher descriptions in User SAI files

When adding a new Publisher entry to a User SAI using Analysis 
Workbench, the Description string is not stored in the SAI file. To add 
Publishers with description strings, the ApE Explorer should be used.

! Issue 4516: Using Formatted Scanner Fields on Japanese machines

Formatted Scanner fields are not aware of multi-byte character set issues 
and should not be used in locales where such characters may be entered, 
such as Japan. In such locales, Free Form Text or Pick List fields should be 
used instead.

! Issue 6725: Running the Windows Scanner on a RAID machine

The partition scanning logic of the Windows Scanners cannot detect 
RAID drives correctly. When scanning machines with a RAID disk 
configuration or machines in a SAN, either run the scanner without 
Administrator rights or run the scanner with a -60 command line switch 
to disable low level disk detection.

! Rights when scanning UNIX systems

When scanning UNIX systems without root access, the scanner may 
output error messages caused by insufficient rights to certain key 
executables required by hardware detection. Such error messages can 
normally be ignored.

! Documentation for scanner -O: and -P: switches is incorrect

The -O: and -P: switches are mutually exclusive and only one of them can 
be used at a time. Which switch is valid for a given scanner depends on 
how the scanner was configured:
Known issues ! 13
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-O: switch -O:<filename> is valid only when the Asset Number Source is set to Scanner 
Command Line (/O switch) in the Asset Number tab page of the Scanner 
Generator. It may contain a fully qualified file name, or just a path name, or just 
a file name.

If a file name is not supplied, the file is named Default.fsf or 
Default.xml.gz.

If only the filename is specified, then the file is stored in the path specified in the 
Offsite Save path specified in the scanner generator

-P: switch -P:<path> is valid only when the Asset Number Source is set to Asset Tag Field 
in the Asset Number tab page of the Scanner Generator. When specified, it can be 
used to override the specified Offsite Save Path.

For compatibility-related issues, see Compatibility information on page 20.

Corrected issues

Desktop Inventory 7.1.1 corrects several issues in v7.0.0. The list below is not 
meant to be comprehensive but covers those problems that were either 
reported by more than one customer or deemed of high importance.

Area Ticket Number Description and resolution

Installation 8501 The Application Encyclopedia user 
preferences database was not always created 
correctly on installation.

PC Scanners 8440 The scanner command-line option (-30) to 
disable video scanning did not also disable 
monitor scanning.

A separate switch to disable monitor 
scanning (-31) was also introduced.

8506 Some asset data configurations could cause 
the scanner to fail with an error message.

8512 The DOS scanner did not correctly update 
asset fields referring to enumerated 
hardware fields (such as CPU Type).

8558 Targeted Scanning would ignore entries 
pointing to the root of a volume, such as C:\.

8559 The Win16 scanner would sometimes not 
detect the correct amount of memory when 
running in Windows 3.1x.
14 " Desktop Inventory 7.1.1 release notes 
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PC Scanners 8632 The shortcuts to show the Log tab in the 
Windows scanners did not work.

8648 Detection of PCMCIA cards in Windows 
did not always work correctly.

7833 The Scanners allowed both -O: and -P: to be 
specified on the command line.

7836 Refilling from an offsite Scan file did not 
work if InfrTool.ini was disabled.

8414 Setting the default view to the Information 
page did not work.

7507 The Scanners would not always pick up 
stored files located in “specific directory”.

8368 The Win32 scanner would crash on 
Windows 95 when USB detection was 
enabled on machines with USB devices.

USB support in Windows 95 does not 
conform to the later standards and the 
Scanners no longer attempt USB detection 
on these systems.

8392 On machines with certain S3 graphics cards 
running Windows NT/2000/XP, monitor 
detection caused the machine to run very 
slowly.

Monitor detection is now disabled for these 
machines.

8769 On machines with a problematic BIOS, the 
Scanners would detect an incorrect size for 
hard disks larger than 9GB when run in 
Windows 9x or DOS.

UNIX Scanners 8601 The UNIX scanners did not correctly 
handle symlinks to non-existing directories.

7851 The Swap File Location detected in the 
Linux scanners was correct but used a 
different syntax from that used for mount 
points.

7891 The UNIX scanners sometimes could not 
detect the correct mount point free space 
and instead showed 0.

Area Ticket Number Description and resolution
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UNIX Scanners 7970 The UNIX Scanners did not correctly 
validate the asset data input, for example 
allowing text input in a numeric field.

7972 The AIX Scanner was not always able to get 
the CPU Serial Number.

8034 The Disk Geometry (Cylinders, Heads and 
Sectors) was sometimes displayed as 0 when 
no data should be displayed.

8147 The AIX Scanner did not always detect as 
much hardware data as it should.

8065 The permissions for the offsite save file in 
UNIX was set to 400 (-r--------, meaning it 
could only be read by the owner, and not be 
written to).

The permissions are now set to 644 (-rw-r--
r--).

8407 The Scan Date of all UNIX scans was 
registered as being exactly 1 day in the 
future.

8708, 8739 The HP/UX Scanner would not scan 
directories in Targeted Scan if a trailing 
slash was found in the directory.

This would be the case if $PATH included a 
trailing slash, for example.

8737 Mount point size figures in UNIX were 
incorrect. The figures recorded were in MB, 
but were shown in KB.

Area Ticket Number Description and resolution
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All Scanners 8401 When using an Asset Field referring to a 
hardware item that can have multiple 
instances (such as MAC address), the 
Scanners used to concatenate all of the 
values, separating them with “\”. 

In scanners where this field was used to 
specify the Asset Tag, the scan file could not 
be saved as a result.

This has been changed so the Scanners now 
pick the first item from the list that 
conforms to the criteria for the field. This 
allows the user to configure a list of 
undesirable or invalid entries in the Ignore 
list.

Scanner Generator 8508 If the user disabled hardware detection, it 
was still possible to set up the software scan 
as a “targeted scan”. Since targeted scanning 
requires extensive configuration 
information to be collected, it can no longer 
be selected if hardware scanning is disabled.

8637 When setting up a Targeted scan, Scanner 
Generator always assumed the “Start 
Menu” setting was unchecked.

8185 The Scanner Generator does not display 
correctly when Large Fonts are enabled. A 
warning message has been added.

8334 Clicking on the field header when defining a 
Sequence field in Scanner Generator caused 
the screen to corrupt.

7737 If the Browse button was used to browse to 
the save location, the Settings.txt file would 
not be created.

Viewer 8515, 8546 When using Advanced hardware view, 
sorting the primary view would cause the 
linked items to be incorrect.

8527 The Find File dialog would not always go to 
the right file.

8528 The Properties dialog for a drive had the 
Capacity and Free Space number swapped 
around.

Area Ticket Number Description and resolution
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Viewer 8530 Viewer allowed some hardware fields and 
derived asset fields to be edited. It now only 
allows editing of standard asset fields.

8553 In Viewer, the Window menu could not be 
used to switch between open scan files.

8600 In the software view, right-clicking on a 
“link” did not always navigate to the 
destination directory.

8204 Viewer would sometimes show an error 
message if the hardware tree was navigated 
after editing asset data.

Analysis 
Workbench

8548 Editing Asset data did not correctly update 
derived fields, and also did not support 
different Asset field setups for different scan 
files.

The Asset data editor now enables editing 
on a per-cell basis instead of on a per-
column basis.

8574 When deleting items from a User SAI, the 
items would not be deleted from the actual 
file unless the option was set to “Delete 
when AW Exits”.

7615, 8583 Export of Stored Files did not work for some 
UNIX scan files.

8624 When using the Change Case function of 
asset data editing, derived fields were not 
recalculated.

7958 The order of columns in the Machine 
window was not stored correctly when 
saving the Window layout.

8248 It was not possible to launch stored queries 
from Analysis Workbench script files.

8089 Relational Exports did not work correctly 
because the exports were not set to Detailed.

Area Ticket Number Description and resolution
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Analysis 
Workbench

8608 When doing a Detailed Machine or 
Relational export, data items in arrays (such 
as shares, environment variables, etc) did 
not have a unique column header.

When exporting such items, the index is 
now appended to the column header (like in 
the machines window).

ApE Explorer 7931 When importing a Master.sai into the ApE 
database using the ApE Explorer on a 
system with a primary language of German, 
the import failed.

XML Enricher 8678 The XML Enricher now verifies that the 
scan file is complete before opening it for 
enrichment.

This allows scan files to be transfered to the 
incoming directory using slow mechanisms 
like FTP.

7916 By default, the XML Enricher waited for 20 
seconds between each scan file, even when 
more scan files were queued for processing 
in the incoming directory.

This delay has been removed.

Area Ticket Number Description and resolution
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Compatibility information

Compatibility matrices for Peregrine products, which identify the hardware 
and software requirements for installing this release, are available in the 
Software pages of the Customer Support web site at:
http://support.peregrine.com. 

Peregrine Systems recommends that you check the web sites of the suppliers 
of the platforms in use at your site to verify that they are still supported. 
Peregrine Systems, Inc. only offers limited support for platforms that are no 
longer supported by the vendor.

Backwards compatibility
The following table contains known compatibility information for this 
release of Desktop Inventory 7.1.1.

Area Description

FSFs In order to ensure backwards compatibility for FSFs collected 
with Scanners from IDD 6.03 and earlier, an FSF Converter 
Wizard is included with Desktop Inventory.

The FSF Converter accepts FSFs from IDD v4.40 to 6.03 and 
converts these to Desktop Inventory Compressed XML 
format. The converted scan files can be used with all Desktop 
Inventory tools, including the XML Enricher.

Scan files collected with Desktop Inventory 7.0.0 do not need 
to be converted and can be used without change in v7.1.1.

Refilling The Desktop Inventory Scanners can perform Asset Data 
refilling from IDD FSFs, even when these have not been 
converted to the new format. This ability allows an existing 
inventory scheme to be continued by simply upgrading the 
Scanners used.
20 " Desktop Inventory 7.1.1 release notes 
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For more information on upgrade issues, please refer to the Desktop 
Inventory Installation and Upgrade Guide.

Additional contact information

Peregrine is committed to ensuring your success with our products. We offer 
a number of ways for you to provide product feedback, suggest 
enhancements, and receive technical assistance with any issues you 
encounter.

Internet
Peregrine Systems has an extensive online support web site available 24 hours 
a day. From this web site you can obtain product licenses, submit service 
requests and surveys, consult our Knowledge Base, review Technical Notes, 
obtain product documentation, and enter enhancement requests.

1 To access the Peregrine Customer Support web site, go to 
http://supportweb.peregrine.com

2 Enter a current login name (this is your valid Support Contract ID) and your 
password. If you do not know your user name and password, contact 
Peregrine Customer Support directly at the telephone numbers listed below.

3 Select the Online Services tab to submit a service request or to obtain a 
license. You will be notified and given a ticket number when your request is 
received by Peregrine Customer Support.

SAIs and ApE Software Application Index files and customized ApE 
databases from IDD 6.03 can be used with Desktop Inventory 
7.1.1, provided the upgrade procedures are followed.

SAI files from v7.0.0 can be used with no changes. 

To upgrade your ApE Database, export the contents of the old 
database to a Read-only SAI first, and import this into the new 
database when the new version has been installed.

Licences The licence for previous versions of IDD and Desktop 
Inventory are no longer valid for Desktop Inventory 7.1.1 
installations. 

To obtain a new licence, contact customer support.

Area Description
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Desktop Inventory 7.1.1
Telephone 
Direct access to Peregrine Customer Support engineers is available by 
telephone. You can find the telephone numbers for all Peregrine products by 
accessing the Customer Support web site at
http://supportweb.peregrine.com.

Use the following telephone numbers for Desktop Inventory product 
support only. Before contacting Peregrine Customer Support, please have 
ready your user name, password, and system information.

International customers outside these areas, please contact your local 
Peregrine Partner for support.

E-mail 
Peregrine also accepts technical inquiries by e-mail. Send your requests to 
support@peregrine.com. You will receive e-mail notification when we 
receive your message.

North America 1-925-469-4200 

5:00 A.M to 5:00 P.M. Pacific Standard Time (U.S.), 
excluding pre-announced Peregrine holidays.

Europe (EMEA) +44 1344 866800

6:00 A.M. to 5:00 P.M. Greenwich Mean Time (England), 
excluding pre-announced Peregrine holidays.

Asia Pacific +65 551 5080

8:00 A.M. to 5:00 P.M. Singapore Time, excluding 
pre-announced Peregrine holidays.
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